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EDITING RESOURCES

INTRODUCTION

This chapter explains the general methods and conventions that Resorcerer
uses to edit group of related resources, without regard to the particular types
involved.  Later chapters document the individual capabilities of each of the
standard Editors.  We concern ourselves here only with those features that
are common to the editing of any resource.

TOPICS COVERED

•     Major and minor resources
•     Opening existing resources
•     Creating new resources
•     The resource editing window
•     Saving and closing open resources
•     Reverting resources
•     Duplicating open resources
•     Editing resource information
•     Changing all resources in a group
•     Searching for text in resources

MAJOR AND MINOR RESOURCES

Resorcerer is designed to let you edit sets of related resources at the
same time, so that you can think of the set as a unit.  Each set of
resources usually has one resource by which it is known, which we call
the set’s major resource, and zero or more minor resources, which are
related to the major resource either explicitly or by some convention,
such as sharing the same resource ID.  In general, Resorcerer lets you
manipulate each resource set by manipulating the set’s major resource.

For instance, a ‘MENU’ resource is a major resource, while the ‘mctb’
(menu color table) resource that shares the same ID as the ‘MENU’ is
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considered its minor resource.  These two types form the resource set
(‘MENU’, ‘mctb’) which collectively we think of as a menu.  In the case
of dialogs, the ‘DLOG’ resource is considered to be the major resource,
and its related ‘DITL’, ‘dctb’, and ‘ictb’ resources are its minor resources.
The four resources together (‘DLOG’, ‘DITL’, ‘dctb’, and ‘ictb’) are
considered to be a dialog, and in fact the Mac’s Dialog Manager treats
them that way.

Of course most types of resources, such as ‘STR#’ (string list) or ‘ICON’
resources do not have related resources.  In this case, we still call the
resource a major resource; it simply happens to have zero minor
resources, and its resource set consists only of itself.

  Note: Resorcerer does not resolve minor resource references
across file boundaries, regardless of whether or not you
have more than one file open.  Also, embedded references
to definition functions, such as ‘MDEF’ or ‘WDEF’
resources, are not counted as references to minor
resources, since the definition functions tend to be shared
among many resources.

  Note: It is possible for a minor resource in one resource set to be
the major resource of another set.  For example, the
Dialog Editor edits ‘dctb’ resources in an easy but non-
general way while editing dialog resource sets; but there
is also a Color Lookup Table Editor that will edit a ‘dctb’
resource directly and more generally as one of the major
resources that it handles.

OPTIONAL MINOR RESOURCES

A minor resource that contains information that extends the attributes
of its major resource for use on later Mac systems is considered an
optional minor resource.  Most minor resources, such as color tables, are
optional.  The best example of a non-optional minor resource would
probably be a dialog or alert’s ‘DITL’ resource.

When you ask Resorcerer to open a major resource, some or all of the
resource’s optional minor resources may not exist in the same file.
While the major resource is open, any optional minor resources that
were missing from the full resource set are temporarily created and
added to the File Window’s lists.  When you finish editing the resource
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set, these optional minor resources will be deleted automatically unless
you have explicitly edited some part of them.

For example, many application resource files contain ‘MENU’ resources
without the associated optional ‘mctb’ (menu color table) minor
resource.  When you edit the ‘MENU’, an associated ‘mctb’ is
automatically created and added to the file temporarily.  It is deleted
from the file when you close the ‘MENU’ unless you have explictly used
the Menu Editor to edit some color information that would be kept in
the ‘mctb’ minor resource.

OPENING EXISTING RESOURCE DATA

Resorcerer edits the data in a given resource in any of three different ways:
via the general low-level Hexadecimal Editor, via the general intermediate-
level Data Structure Editor, or via the specific editor dedicated to that
resource type.  Unless you tell it otherwise, Resorcerer tries to open
resources using the highest-level, most specific editors first.

Only dedicated editors can edit sets of related resources.  The Hex Editor
and the template-driven Data Editor don’t make any distinction between
major and minor resources: they assume that the resource they are asked to
edit is a major resource with no minor resources.  If you use either of these
two editors on a member of a resource set, you may have to remember to
ensure that any other resources in the set are changed consistently.

DEDICATED EDITORS

Dedicated editors are hand-coded routines compiled into Resorcerer that
directly edit sets of resources simultaneously.  An editor dedicated to a
particular set of resource types knows the structure and meaning of the
data kept in the resources and is responsible for presenting you with an
editing interface tailored to those types.  Because of this knowledge, a
dedicated editor can take care to ensure the consistency of the resource
data (especially between related resources in a resource set),
do error checking, or other operations that depend on
knowledge, conventions, or other assumptions about the
data being edited.  Resorcerer contains dedicated editors for
many of the standard Mac types.

Note: Resource types shown in boldface in a file’s
Types List signify that a dedicated editor is
available.
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DATA-PARSING TEMPLATES

Templates are resources of type ‘TMPL’ that you can create using
Resorcerer’s dedicated Template Editor.  They let you extend
Resorcerer’s knowledge about the structure of new or custom resource
types without your having to create a dedicated editor for these new
types.  The Template Editor lets you create powerful templates for
editing both simple and complex resources of your own design.  For
more on how to create and use templates, see the “Template Editor” and
“Data Editor” chapters later in this manual.

Note: The first four characters of the ‘TMPL’ resources’s name
should be the resource type that the template has been
designed to parse.  Resorcerer ignores all ‘TMPL’
resources with names having fewer than four characters.

When you are viewing resources of some type in the Resources List, you
can use the Data button to open a resource with its template.  If
Resorcerer can’t find a template, the button will be disabled.  It looks for
template resources in the following places in the following order:

  •   in the file in which the resource to be opened is found;
  •   in the set of all files (with unparenthesized names) in the

  Resorcerer Templates or the Private Templates folders.
  •   in the Resorcerer application’s own resources.

Note: You can set a preference to keep Resorcerer from recognizing
templates in the file in which the resource is found.  For more on
this, see the “Preferences” chapter.

Resorcerer will pause to re-scan all template folders every time you
bring the application to the front and a folder’s modification date has
changed, as well as every time any file with a template in it is saved.

THE HEX EDITOR

The Hex Editor is the low-level editor that can edit any resource data
without regard to the type or structure of that data (for more on it, see
the “Hex and Code Editor” chapter).  It is always available as the editor
of last resort.  You can explicitly invoke the Hex Editor by using the
Hex button in your File Window.
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OPENING RELATED RESOURCES

When you ask Resorcerer to open a resource using the best way possible
(that is, by simply double-clicking on an entry or clicking in the Open
button, and not by clicking on the Data or Hex buttons), Resorcerer
first checks whether the resource type is a major or minor type.  If it is a
minor type, it determines the first major resource to which the minor
one is related and asks
which you want to open.
Usually, you’ll want to
open the major resource
(which will open the
minor one with it), but
you can open the minor
one by itself.

Note: If you are familiar with Apple’s ResEdit, the above alert
will help you get out of the habit of editing dialogs and
alerts by opening ‘DITL’s.  In Resorcerer, you simply open
the ‘DLOG’ or ‘ALRT’ major resources instead, and the
minor ‘DITL’ resources get opened automatically.

When a major resource’s data is
open for editing, Resorcerer places
a • next to the resource’s entry in
the Resources List.  If the major
resource has related minor
resource(s), it also places a • next
to each opened minor resource in
the minor resource’s list.  This
makes it easy to find open
resources while browsing through
the resources in a file.

Only one Editor can access a given resource at a time.  If you ask Resorcerer
to open any resource, whether major or minor, that is already open (i.e. the
resource has a • next to its entry in the Resources List), the editing window
whose resource set includes that resource is brought to the front.

Note: If two ‘DLOG’s both refer to a common ‘DITL’, you will not be able
to open both dialogs at once since the ‘DITL’ will have been
opened as part of the first ‘DLOG’s resource set.
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CREATING NEW RESOURCES

The easiest way to create a new resource for a given file is to make sure that
the File Window is in front, and then click in the New button.  This is
equivalent to choosing the New Resource command in the Resource menu
(which also works when the front window is a resource editing window).

Before creating the new resource (and any of its minor resources) Resorcerer
must determine the type of major resource to create.

If the Resources List is the Active List and is filled with resources of a given
type, or if a specific resource editing window is in front, then Resorcerer
assumes that you want to create a new major resource of the same type as
represented by the front window.  The resource ID(s) used for the new
resource set are determined by searching for the first free ID after some
starting ID (see the “Preferences” chapter for more on starting IDs).

If the Types List is the Active List of
a File Window that is in front, then
Resorcerer displays its New
Resource dialog, which gives you
the opportunity to specify the type
of resource to create, as well as the
ID, name, and any of the attributes,
prior to creating the major resource.

Sorcery: The first selected type in the file’s Types List is used as the
default type in the New Resource dialog when it is first
displayed.  For example, you can click on the ‘MENU’ entry in the
Types List, then click on the New button, and ‘MENU’ will
already be selected for you in the New Resource dialog.

Enter the four-character resource type directly for custom types, or choose a
known type from the list of current predefined resource types.  In either
case, Resorcerer automatically fills in the next available resource ID to use
when creating the new resource.  You can enter any number you want if this
default is not acceptable.

The list of known types presented to you consists those resource types
handled by all of Resorcerer’s dedicated editors; all distinct templates
(resources of type ‘TMPL’ with resource names at least four characters long)
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among the current file’s resources, Resorcerer’s templates folders, and
Resorcerer’s own resources; and all synonyms represented in the resource
synonyms list in your preferences.

Although the resource ID that you or Resorcerer supplies is usually used,
dedicated editors can change the ID for reasons of their own.  In particular,
the Dialog/Alert Editor will attempt to use a resource ID for a new ‘DLOG’ or
‘ALRT’ that is also not yet the ID of any ‘DITL’ resource in the same file.
Since both ‘DLOG’ and ‘ALRT’s are major resources with minor ‘DITL’
resources, this means that no ‘DLOG’ will have the same ID as an ‘ALRT’
unless you specifically override these automatically chosen resource IDs.

The Unique ID button next to the ID field in the New Resource dialog lets
you find an ID that is unique for the selected type among all open resource
files.  Each time you click on it, a new unique ID is entered into the ID field.

Note: Usually you don’t need to use this capability, since Resorcerer will
avoid ID conflicts anyway using a sequential search.

Finally, you can also give the major resource you are about to create a name
and click in the appropriate checkboxes to preset the attributes it will have.

Once Resorcerer determines the type and ID of the resource being created,
as well as the editor to use for that resource, the editor creates the new data
for the major resource and any minor resources.  Resorcerer installs these
new resources into the File Window’s lists, and then opens them for editing.
If you do not explicitly change any information kept in any optional minor
resources, they will be automatically deleted when you close the editing
window for the resource set.  It is up to individual dedicated editors to decide
whether to keep or delete new but unchanged optional minor resources (see
the chapters for the individual editors for details).

Sorcery: cN is the keyboard equivalent of the New command in the
Resource menu when a File Window is the frontmost window.
c . (period) is the keyboard equivalent of the Cancel button in
the New Resource dialog.
scP (Shift cP) is the keyboard equivalent of the New button
for ‘PICT’ resources, regardless of what the frontmost window is.
If there is no open file, the new ‘PICT’ resource is placed in the
Resource Scrap file.  See the “The Picture Editor” chapter later in
the manual.
Option-New (or Option-Create) will bypass any dedicated editor
and ask either the Data Editor or the Hex Editor to create and
open the new major resource by itself.
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THE RESOURCE EDITING WINDOW

With the exception of the Dialog Editor, all resource editors present you with
editing dialogs using Resorcerer’s standard non-modal document window.
On monochrome and low-resolution color screens, these windows differ from
the usual Mac document window in that the drag bar is shown in gray when
the window is active.  Under System 7, Resorcerer’s windows follow the
usual color window rules.

The title of the window indicates the major resource type, ID, name if any,
and file to which the resource belongs, such as ‘ICON 133 “Warning” from
Resources.rsrc’.  If the resource is new, then the fact that it was just created
is also displayed, as in ‘New ICON 134 from Resources.rsrc’.

Note: Titles of ‘WIND’ and ‘DLOG’ resources being displayed as
themselves are taken from the resource data rather than being
formed from the resource type, ID, etc.

Sometimes, titles of resource editing windows, and especially of sub-windows
for resource items, can get pretty long.  When a title written in the standard
system font doesn’t fit, Resorcerer will attempt to display it in a smaller type
style before clipping the title at the right end of the window’s drag bar.

To make resource browsing and editing safer, most
resource editor dialogs contain a Cancel button, on
which you can click to close the resource set without
saving any changes that you may have made.  This is
the same as choosing Cancel Edit Session from the
Resource menu, which is available for all resource
editing dialogs whether they include a Cancel button
or not.

If you don’t want Resorcerer to ask you to confirm
canceling your changes, you can uncheck the
Confirm resource cancels and reverts box in the
Confirm Preferences section of the Preferences… dialog.

Sorcery: c . (period) is the keyboard equivalent of  Cancel Edit Session.

Double-clicking in the drag bar of a resource editing dialog brings
the File Window to which the resource set belongs to the front.
Double-clicking on a resource editing dialog’s sub-window brings
its owning dialog window to the front.



63

EDITING RESOURCES

SAVING AND CLOSING OPEN RESOURCES

When you click in a resource editing dialog’s GoAway box, the data for all
the resources in the resource set being edited gets saved back into its
internal form, and replaces the data that the resource set was opened or
created with.  The new data is not written to disk, however, until you close
or save the file to which the resource set belongs.

Resorcerer will confirm with you whether you want to save any changes to
the resource set (if you’ve made any changes).  If you do not want
confirmation, Resorcerer assumes you want to save any changes.  Again,
these changes are only saved to the in-memory copy of the resources, not to
the original disk file.  For more on how to set your confirmation preferences,
see the “Preferences”’ chapter later in the manual.

Before saving or closing an open resource set, any sub-dialogs that were
opened by the editor to let you edit some piece, item, or field of the resource
set must be closed in order to determine if any changes have been made to
the set overall.  Resorcerer automatically closes all sub-dialogs as if you had
clicked in their GoAway boxes, under the assumption that whatever item or
field they edit should be saved.  Resorcerer also closes any resource
information editing dialogs for the resource set.

The Resource menu contains three hierarchically
related commands for closing resource editing dialogs.

The first closes one window at a time.  If the window
is a resource editing dialog, the command is either
Close Resource or Close Resource Set, depending
on whether the editing dialog’s resource set has more
than one resoure in it.  If the window is a resource
editing sub-dialog, the command is named Close
Resource Item.  For other types of windows, it is
simply Close Window.

The second command closes all editing dialogs of the same kind.  For
example, if the frontmost window is an editing dialog for a ‘PICT’ resource,
choosing Close All This Type from the Resource menu will close and save
all ‘PICT’ resource editing dialogs from the same file.

The third command, Close All, saves and closes all editing dialogs related to
the file determined from the frontmost window.  Resorcerer automatically
invokes this command whenever you close a given File Window in order to
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determine if any changes have been made to the file overall.

Sorcery: cW is the keyboard equivalent for Close Resource, Close
Resource Set, and Close Window.

Option-clicking in any editing dialog’s GoAway box is equivalent
to choosing Close All This Type from the Resource menu.

REVERTING RESOURCES

Revert File in the File menu reverts all changes to
an opened file.  However, you may only want to discard
the changes to some resources in the file while
maintaining the changes in others.  The Revert
command in the Resource menu lets you selectively
revert resources to their previous state, either to what
it was prior to the most recent in-memory edit, or to
the current state as recorded in the disk file.

Prior to discarding any changes you have made,
Resorcerer will confirm with you whether or not you
want to throw the changes away.  You can disable this
confirmation by unchecking the Confirm resource cancels and reverts
box in the Confirm Preferences section of the Preferences… command in
Resorcerer’s Edit menu.

REVERTING OPEN RESOURCES

If the frontmost window is an editing dialog for some opened resource
set, Revert will affect only the resources in that set.  This is equivalent
to Cancel-ing the editing dialog and reopening it.  This does not revert
the resources to their value on disk, only to their value prior to your
most recent edit of them.  If you have not made any changes since
opening the resource set, then the Resource menu’s Revert command
will be disabled.
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REVERTING CLOSED AND CHANGED RESOURCES

If a File Window is the frontmost window, then Revert will revert all
selected resources to their state found on the disk.  Only resources that
are currently closed and changed are reverted (that is, resources with a
dot next to their entries in their respective lists).

When the Types List is the Active List of the File Window, then all
closed and changed resources of every selected type are reverted.  If
some of these resources are marked with a checkmark, then Resorcerer
will ask you whether you want to revert all selected types or only those
resources of the selected types that are marked.

If the Resources List is the Active List, then only selected resources of
the type displayed in the list are reverted.

If you have checked the Include related resources or the Include
owned resources boxes in the Selection Preferences section of the
Preferences… command in the Edit menu, then all resources related
to or owned by a resource selected for reverting will be reverted also.

  Note: In order for related or owned resources to be reverted,
their major or owning resource must be marked changed
also.  For example, if you change a ‘DITL’ resource using
the Hex Editor instead of the Dialog Editor, the related
‘DLOG’ will not be marked changed, and the Revert
command will not consider it (and its related ‘DITL’) a
candidate for reverting even if the ‘DLOG’ is selected.  In
this case, you would have to explicitly select the changed
‘DITL’ to revert it.
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DUPLICATING RESOURCES

DUPLICATING OPEN RESOURCES

Whenever a resource set is open for editing,
Duplicate Resource in the Resource menu
will create a duplicate set of resources having the
same state as those being duplicated, and open a
new editing dialog for the new resource set.

New resource ID numbers are assigned by
searching upwards for the next available free ID
number.  The duplicate resources are given the
same resource attributes as those being
duplicated, with the exception of the resource
name, which is prepended with “Copy of” if the
name existed in the original.

DUPLICATING CLOSED RESOURCES

After selecting the resource or resources to be
duplicated in the Resources List of a File Window,
choose either Duplicate Resource from the
Resource menu, or Duplicate Selection from
the Edit menu to duplicate the selection.

When the Resources List is the Active List,
Duplicate Selection in the Edit menu will
duplicate all selected resources.  Unlike copying,
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duplication entails assigning new non-conflicting resources IDs to the
duplicates and any of their related resources.  The duplicates are left in
the same file as the originals.

Before Resorcerer can duplicate your selection, it asks you to specify the
resource ID to start allocating from as it creates duplicates.  Resorcerer
chooses the next free ID higher than the last selected resource’s ID as a
default starting ID, but you can change it to any ID you prefer.  It then
allocates IDs to the duplicates sequentially upwards, skipping over any
that are already assigned to any existing resources in the file.

You can also optionally choose whether to duplicate the attribute bits,
and/or whether you want to prefix the duplicate resource names with
“Copy of ”.

To duplicate an open resource while you are editing it, use the
Duplicate command in the Resource menu.

EDITING RESOURCE INFORMATION

For every resource in a file, the Macintosh maintains a set of information
that consists of the resource’s ID number, its resource type, its optional
name, and a set of bits that indicate how the Mac should treat the resource
under a variety of conditions.

The Resources List of a File Window always displays
the attributes of the resources in its list.  You can
change the attributes by first selecting the resources
you want to change, and then choosing Resource
Info from the Resource menu (Get Info in the Edit
menu will also work if the File Window is frontmost,
but Get Info may have different meanings in
different contexts).  A resource information dialog is
opened for every selected resource.  The window title
shows which resource is which.

Sorcery: You can open information dialogs for each resource related to or
owned by a selected resource by holding the Option key down
when you click on the Get Info button.
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When a resource editing window
is frontmost, Resource Info
opens the information dialogs for
all resources in the set
represented by the window.

Each entry in the Resources List
that has its attribute information
open for editing has a diamond
placed next to it.

CHANGING A RESOURCE’S ID

To change the ID of a resource, enter the number you want in the
resource ID field of its resource information dialog.  The associated
entry in the Resources List of a File Window is automatically updated,
as are any open editing dialogs that refer to the ID in their titles.

You cannot, however, set the ID to that of another resource of the same
type that already has the ID assigned to it.  In this case, the change is
not reflected anywhere else, such as in the Resources List or open
resource window titles.  When you try to close the information dialog,
Resorcerer will complain if there is still an ID conflict.

  Note: It is a good idea to keep the ID you use for alert (‘ALRT’)
resources separate from those you use for dialog (‘DLOG’)
resources, because they both refer to the same type of
minor ‘DITL’ resource.  Resorcerer will notify you if you
try to assign an ID to either an ‘ALRT’ or ‘DLOG’ that is
already in use for the other type of resource.

Resources in a File Window’s Resources List are sorted by resource ID ,
name, or attribute, among other criteria.  However, during the time
that you are editing this information, the resource entry in the list may
become temporarily out of order.  When you close the information
editing dialog, or when you click on the File Window to bring it to the
front, Resorcerer re-sorts the Resources List.
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CHANGING MINOR RESOURCE IDS

When you change the resource ID of a major resource of a resource set,
it is almost always the case that the related minor resources need to
have their IDs changed also.  It is also sometimes necessary to change
resource ID references that are kept in fields within the resource data
in order to maintain consistency among all resources in the set.

When you have the Include related (minor) resources in selections
preference set, Resorcerer will assign the ID you’ve specified for the
major resource to all of its minor resources, including changing any
internal resource ID references within the data.  This lets the major
resource represent its minor resources to you when assigned new IDs.

Dialogs

The ‘DLOG’ resource is the major resource for a set of dialog
resources that includes its item list (‘DITL’), its window color table
(‘dctb’), its item list’s colors and text styles (‘ictb’), and its Dialog
Editor extensions (‘DLGX’) resource (for more on these, see the
“Dialog Editor” chapter).  When you change the resource ID of the
‘DLOG’ resource, its ‘dctb’ resource is renumbered using the same
ID, in order for the linkage between the two to continue to be
recognized by the Mac’s toolbox when your application runs.
Although technically the ‘DITL’ resource does not have to be
renumbered, since its resource ID is explicitly encoded in the ‘DLOG’
data, it is a good idea to change the ‘DITL’ ID along with the ‘DLOG’
that refers to it, simply because life is easier when you use the same
ID for all resources in the set.  When the ‘DITL’s ID gets changed, its
related ‘ictb’ resource is given the same ID, and the reference within
the ‘DLOG’ data is changed as well.  Finally, the Dialog Editor
expects the ‘DLGX’ resource to have the same ID as the ‘DLOG’
resource of which it is an extension, so its ID is conformed as well.

Alerts

The ‘ALRT’ resource is really just a variant of a ‘DLOG’ resource,
with the exception that its color table is kept in a resource of type
‘actb’.  When you change the ID of an ‘ALRT’ resource, Resorcerer
conforms its minor resources’ IDs in the same way as it does for
‘DLOG’ resources, described above.
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Windows

The ‘WIND’ resource is the major resource that can have a minor
window color table (‘wctb’) resource, which must have the same
resource ID as the ‘WIND’.  Resorcerer will renumber both when you
renumber the ‘WIND’ resource.

Menus

The ‘MENU’ resource can be accompanied by a menu color table
minor resource (‘mctb’), which must have the same ID as the
‘MENU’.  The ‘MENU’ data contains a field, called the menuID , that
normally contains the resource ID of the ‘MENU’, but can be
different.  It is a good idea to maintain consistency between the
resource ID and the menuID , again in order to keep life simpler.
When you change the resource ID of a ‘MENU’ resource, the menuID
field is conformed to the new ID.  In addition, all menuID  entries in
the optional color table that refer to the menuID  are changed.  The
resource ID of any accompanying balloon help (‘hmnu’) resource gets
changed also.

Controls

The ‘CNTL’ resource also has a minor color table (‘cctb’) resource,
which must have the same ID as the major resource.  When you
renumber the ‘CNTL’, any ‘cctb’ with the same (old) ID is
renumbered also.

CHANGING AN OWNED RESOURCE’S ID

Owned resources have resource IDs that are negative in the range of -1
to -16384, and which have various information encoded in the 16-bit
resource ID word (for more on this, see the “Macintosh Resources”
chapter).  The resource information dialog automatically decodes
negative resource IDs into three fields, which specify

1) the type of the owning resource;
2) the resource ID of the owning resource; and
3) the sub-ID of the owned resource.

The sub-ID lets you distinguish among resources that are the same type
and owned by a common resource, as specified in the first two fields.

When you enter or view a negative resource ID in the resource ID edit
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box, it is automatically decoded into the three fields and displayed
simultaneously.  Similarly, when you change any of these fields, the
change is re-encoded into a new negative resource ID that is displayed
back in the edit box.  The Owner checkbox is set automatically.

  Note: The resource ID for the owning resource can only be in
the range from 0 to 63.  The sub-ID of the owned resource
can only be in the range from 0 to 31.

CHANGING IDS OF RESOURCES THAT OWN OTHER RESOURCES

Certain types of system resources can explicitly own other resources (for
more on owned resources, see the “Macintosh Resources” chapter earlier
in the manual).  The owned resources have the owner resource’s ID
encoded directly within their own IDs.  The Resources List in the File
Window always decodes owned resource IDs for you.

When you change the resource ID of the owner, it is necessary to change
the ID of every owned resource as well if you want to maintain the
linkages between the owner and its owned resources.  If your Include
owned resources in selections preference is set, Resorcerer will
automatically renumber every owned resource when you assign a new
ID to the owner.

If you also have your Include related (minor) resources in
selections preference set, Resorcerer will check each renumbered
owned resource for related minor resources, and renumber them also, as
described in the previous section “Changing minor resource IDs”.  Thus,
if a resource owns a ‘DLOG’ resource and its related ‘DITL’, when the
‘DLOG’ is renumbered, its ‘DITL’ will be renumbered with the same ID,
and the ‘DLOG’s internal itemsID  field will be updated as well.

CHANGING A RESOURCE’S TYPE

Under some circumstances, you may need to change a resource’s type,
so as to create a synonym type whose resource data will have the same
format as some other type (e.g. ‘STR ’, ‘FCMT’, and ‘mstr’ resources all
have the same data format—a Pascal string—and hence are synonyms
of each other).  You can enter the new 4-character type into the resource
type field of the information dialog to change the type.  Resorcerer will
complain if the type is not exactly four characters long when you try to
close the dialog.
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If the resource whose type you are changing is showing in the Resources
List, it will be deleted from the list of resources of its old type and
inserted into the list of resources of its new type.  The Resources List
will then be filled with the list for the new type.  When you close the
information dialog, Resorcerer will check that there is not a new ID
conflict.  If there is, you must correct it before you can close the dialog.

Resorcerer will not let you change the type of a resource whose data is
currently opened for editing, since that would cause as much confusion
to you as it would to Resorcerer.

  Note: Changing the type of a resource should always be done
with care, since changing a resource’s type does not
change its data, which remains in the format of the old
type.  Unless the types are synonyms, the data of the old
type will almost certainly look like garbage when the
editor for the new type is asked to edit it.

CHANGING A RESOURCE’S ATTRIBUTE BITS

The five standard resource attribute bits for each
resource are displayed in the lower left of the resource
information dialog, using five checkboxes.  Each
checkbox is labeled with both an icon and the system
name for the bit.  The icon is the same as is shown in
the Resources List.  These bits are more fully
explained in the earlier chapter, “Macintosh Resources.”

  Note: While you are editing a file of resources, Resorcerer
ignores the settings of any of these attribute bits.  In
particular, resources with the sysHeap bit set are not
loaded into the system heap and protected resources are
not protected.  These attributes are set when the file is
saved back to disk.

If you open a file with any resources compressed using Apple’s internal
compression methods (under System 7), a sixth attribute bit, for the
“extension” attribute, is made visible.  However, you cannot change this
bit without explicitly making a change to the resource data.  This is
because the Resource Manager processes the resource into its
decompressed form when Resorcerer asks for the data, and the Resource
Manager cannot recompress resources when writing them back out.
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CHANGING A RESOURCE’S NAME

Every resource can have an optional name, which is just an arbitrary
string of from 0 to 255 characters.  Most applications request resources
by resource type and ID, but some are accessed by their type and name.
However, the main use of resource names is to help remind you what
the resource is for, since resource IDs are eminently unmemorable
unless you are a machine.

You can type the name you want to give to a resource directly into the
resource name field of the resource information dialog.  Whatever you
type is immediately reflected in the Resources List of the file to which
the resource belongs.

  Note: Resource names in the Resources List of a file are shown
enclosed in double quotes, unless the name is empty.  This
enables you to to tell the difference between an empty
name and a name consisting of, say, blanks.

CHANGING ALL RESOURCES IN A GROUP

The resource information dialog lets you set resource
information for any given resource.  Sometimes,
however, you’ll want to change the attributes of a
group of resources to the same or similar values.
Resorcerer’s powerful Change All… command in the
Resource menu lets you do this easily without
having to open the info dialog for each resource.

Change All… brings up a dialog that lets you specify
a group of resources to change, and the change to
make.  When you click on the OK button, all resources
in the group you’ve chosen will be changed
accordingly.  If you make a mistake, you can immediately choose Undo to
restore the changed information.
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The left side of the Change
All… dialog contains a set of
radio buttons that let you
choose what it is you want to
change: attribute bits,
resource IDs, names, or the
resource types of the group of
resources you’re interested
in.  As you choose one of
these, the bottom of the
dialog fills with various fields
and checkboxes that let you
specify the details of the
changes you want to make.

The right side of the dialog consists of a set of radio buttons that lets you
choose the type of group of resources to change.  You can change:

• all resources in the frontmost File Window, regardless of type,
marking, or selection;

• all resources in the file that are marked with , regardless of type
or selection;

• all resources of the type currently being displayed in the
Resources List of the frontmost File Window; or

• all resources represented by the current selection in the frontmost
File Window’s Active List.  If the Types List is the Active List,
then all resources whose types are selected will be considered as a
candidate for changing; if the Resources List is the Active List,
then only those resources of the type being displayed will be
considered for inclusion in the group to be changed.

CHANGING ALL RESOURCE ATTRIBUTE BITS

Click on the Attributes radio button on the left side of the Change
All… dialog.  Below the radio buttons, five checkboxes appear on the
left, one for each attribute bit.  The five checkboxes display the name of
the attribute bit, and the icon used to represent the bits in the
Resources List display.  To the right of the checkboxes a set of radio
buttons represents what you can do with the bits you’ve checked.  The
three possible actions of the radio buttons let you:
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• add only those attribute bits that are checked in the five
checkboxes to the attribute bits of all resources to be
changed;

• subtract only those attribute bits that are checked in the
five checkboxes from the attribute bits of all resources to
be changed;

• copy the state of the five attribute bit checkboxes directly
to each resource to be changed, replacing all of the current
attribute bits.

The most common change to make to all of a group of resources is to add
or subtract a single attribute bit.  For instance, ‘DLOG’, ‘DITL’, and
‘dctb’ resources should generally be purgeable, since the Dialog
Manager reads them only to make copies before creating the dialog.  To
ensure that they are purgeable, you can select the ‘DLOG’, ‘DITL’, and
‘dctb’ entries in the Types List (making it the Active List) and then
choose Change All… from the Resource menu.  Initially, the
Attributes radio button is already selected, so you can then check the
box marked Purgeable (with the trash can icon).  Next make sure that
the Add checked radio button to the right is also selected, and then
click on the OK button to make the change.

CHANGING ALL RESOURCE ID NUMBERS

Under some unusual circumstances you may want to change the
resource IDs of a group of resources.  Since resources should not have
the same ID, this change assigns consecutive IDs to consecutive
resources as they are scanned in the group, starting from a given ID.

Click on the ID Numbers
radio button on the left of the
Change All… dialog.  Below
the radio buttons, a field
appears that asks for the
first ID to begin assigning to
the group of resources to
change.  Click on the OK
button to go ahead with the
change.

Usually, you will only want to change a group of resources that all have
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the same type.  If the group to be changed consists of more than one
type, then each time a new type is scanned from the group, the ID
counter being used to assign IDs is reset to the starting ID you
originally specified.

Resorcerer will skip over any resources not in the group to be changed
which have IDs that conflict with the range of IDs about to be assigned.
For example, if you ask to renumber ‘PICT’s 400 to 405 starting at 300,
but ‘PICT’ 302 already exists, then ‘PICT’s 400-401 will be renumbered
to ‘PICT’s 300-301, ‘PICT’ 302 will be left as is, and ‘PICT’s 402-405 will
be renumbered as ‘PICT’s 303-306.

If the group of resources you are changing the IDs of includes major
resources related to minor resources, and your Include related
(minor) resources in selections preference is set, the minor
resources will have their IDs conformed to that of the major resource.
This process is described in the earlier section, “Changing a major
resource’s ID”.

  Note: Changing IDs in a massive way like this is only useful on
very rare occasions, such as re-organizing certain kinds of
resource files, and should only be done if you know what
you’re doing.  Applications access most resources by ID
numbers that are compiled into their code which will
become out of sync with the changes you make using
Change All….

RENUMBERING RESOURCES BY NAME

To renumber a set of resources of the same type alphabetically by name,
use the View menu to sort the Resources List by Name, and then use
Change All… to change their resource IDs consecutively from some
starting ID.

CHANGING ALL RESOURCE NAMES

Click on the Names radio button on the left side of the Change All…
dialog.  A field for entering the name you want to use appears below.
Click on the OK button to effect the change.  The empty name is legal,
and will cause all names in the resources to be changed to be erased.
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CHANGING ALL RESOURCE TYPES

Under some circumstances,
you may need to change the
types of a group of
resources.  After
determining which
resources should be
changed, click on the Types
radio button on the left side
of the Change All… dialog.
A field appears below that
lets you enter the four-
character resource type to which you want all resources in the group to
be changed.

All affected resources are temporarily deleted from the file, assigned the
new type, and then re-inserted into the file, using the same IDs they
had before the change.

If any of the resources in the group to be changed is open for editing,
Resorcerer will complain.  You must close the open editing windows
first before you can change their resources’ types.

SEARCHING FOR TEXT IN RESOURCES

A common problem when editing resources is to find a resource such as an
error string or a dialog, that contains a word or phrase that you remember,
or to find all resources containing such a word.

For instance, you may want to find all alerts that have
the word “Okay” in them, since you want to replace it
with “OK” everywhere.  Or you need to find the
‘MENU’ resource that has the word “Search” in some
command.  Or you might want to find all templates
that have a “FIXD” field in them.

Resorcerer’s Find All… command in the Resource
menu allows you to search a group of resources for a
text string.  The command works similarly to the
Change All… command: you specify the group of
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resources to search (which
can range from all
resources in many open
files down to only the
frontmost open resource
from the current file), and
the string to search for, as
well as other attributes of
the search.  You also
specify the action to be
performed when a
matching resource is found.  When you click on the OK button, the search
begins.  If no matches are found, Resorcerer beeps once to indicate so.

Resources that match the text you’re searching for can have any combination
of three actions performed on them:

1)   they can be opened for further searching,
2)   they can be marked with a ✓ in their File Window lists, or
3)   they can simply be left selected in their File Window lists, depending

on which action checkboxes you click on in the Find All… dialog.

You can set the text search to be case-insensitive or case-sensitive by
checking the Ignore case box in the dialog.

The possible classes of resources to search through are chosen by clicking on
one of the radio buttons in the left panel of the Find All… dialog.  You can
search through:

     • all resources in all currently open resource files, if more than one
is open;

     • all resources in the open file represented or referred to by the
frontmost window;

     • all resources marked with a  in the current file;

     • all resources of the type being displayed in the Resources List of
the current file;

     • all resources represented by the current selection in the Active
List of the current file;

     • all resources from the current file that are now opened for editing;

     • or the resources represented by the frontmost editing dialog only.
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In all cases except the first, the current file is determined by looking at the
frontmost window.  If it is a File Window, Resorcerer uses that file; if it is a
resource editing dialog, then Resorcerer uses the file from which the
resource set was opened.

SEARCHING RESOURCE DATA

The most common type of search is through the data of the resources in
the search group.  Resorcerer searches all resources in the group you
have specified using a one- or two-step method, depending on whether a
resource to be searched is already open for editing or not.

If a resource to be searched is not open for editing, Resorcerer makes a
generic search of its data, without regard to its structure, searching for
at least one match with your text.  If a match is found then the resource
is regarded as a possible match, marked with a ✓ or selected if you have
requested so, and/or opened if you have requested so.

If the resource is opened (or was already open), Resorcerer continues
with the second step of the search by asking the editor to re-search the
opened resource.  Since only the editor knows about the structure of the
data, it can then display or highlight or open any matching items in the
data.

For instance, the Menu Editor, when asked to search an opened
resource for a piece of text, will highlight all commands in the menu
that contain a match with that text; the StringList Editor will do the
same for every string that contains a match, etc.  The Data Editor also
works similarly.

The initial generic search allows Resorcerer to avoid loading editors into
memory for resources that don’t have any matching data.  However, this
step of the search will occasionally find a match that makes no sense
given the structure of the data.  For example, since the strings in a
‘STR#’ are packed in the data, the last characters of one string, along
with the first characters of the next string (including the length byte)
might conceivably match the search text, even though nothing in either
string matches.  Since only editors know the structure of the data,
Resorcerer may still open the resource, but the editor will not find or
highlight any match.  If you have not requested that matching resources
be opened (only selected or marked), then the match may be spurious
without your knowing it.
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Each individual editor can choose to respond to a matching piece of text
in any way it is designed (for more on individual editors, see the
appropriate chapters later in this manual).  Typically, the Editor selects
whatever field or item in the resource matches, and automatically
highlights the matching text at the first editing opportunity so that you
can issue a Paste command to replace the matching text with some text
from the clipboard.

Certain Editors, in particular, the Picture Editor, which simply displays
a ‘PICT’ resource, can’t highlight any matching internal text strings
within the data; therefore Resorcerer asks the Data Editor to open the
‘PICT’ with its template, and any matching text fields can then be
highlighted for you.

SEARCHING RESOURCE NAMES

You can also use Find All… to search through the resource names of
resources in the search group, instead of the resource data.

Click in the Resource Names radio button in the lower left of the Find
All… dialog to restrict the search to names only.  Resources whose
names contain a match to your search text will have the selected action
performed on them.

If you are just searching for one resource name in particular, you will
probably want to use the File Window’s direct searching capability, as
documented in the “Operating the Resources List” section of the earlier
“Editing files” chapter.  In short, when the Resources List is active, type
any characters in the name you are looking for, and use the Tab key to
select each resource with a name containing the characters you typed.


